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Class — V1
Lesson 1 : Introduction of Computer

Multiple choice questions :

1. (b) 2. (¢) 3. (a)

4. (d) 5. (c) 6. (a)
Write ‘T’ for true and ‘F’ for false statements :

1.T 2.T 3.T

4. F 5.F

Fill in the blanks :

1. Napier 2. transistors 3. palmtop
4. hardware 5. processor 6. nibble

Answer the following questions in short :

1.

5.

A computer is an electronic device that performs
mathematical and non-mathematical operations with the
help of instructions to process the data to achieve desired
results.

First-generation computers relied on binary-coded
language, which is also known as the machine language
(i.e. language of Os and 1s).

Every computer contain — Input devices, CPU, Memory
Unit and Output Unit.

An input device is any hardware that sends data to the
computer. Without it, a computer would only be a device
for display and no interaction would be possible.

A bit is an elementary unit of the memory. i.e. there are
only two possibilities for each digit, either 0 and 1.

Answer the following questions in detail :

L.

(i) First Generation (1940 — 56) Vacuum Tubes

(i) Second Generation (1956 — 63) Transistors

(iii) Third Generation (1964 — early 1970s) Integrated circuit
(iv) Fourth Generation (Early 1970s) Microprocessors

(v) Fifth Generation (Present and Beyond)

Secondary memory is also known as auxiliary memory. It
is used for storing data or programs on a temporary or
permanent basis. Secondary memory refers to storage
device. It may also refer to removable storage media,
such as USB flash drives, CDs and DVDs. Unlike
primary memory, secondary memory is not accessed
directly by the CPU. Instead, data accessed from
secondary memory is first loaded into RAM and is then
sent to the processor.



While secondary memory is much slower than primary

memory, it typically offers far greater storage capacity.

Secondary memory is non-volatile, meaning it retains its

data with or without electrical power. Secondary memory

is used to store "permanent data,".

MU is that part of the computer where the data is stored

and is accessible to CPU. The various measurement units

of computer memory are given here :

Bit : A binary unit is logical 0 and I representing a

passive or an active state of a component in an electric

circuit.

Byte : A group of 8 bits is called byte. A byte is the

smallest unit which can represent a data item or a

character.

Nibble : A group of 4 bits is called nibble.

Word : A computer word like a byte is a group of fixed

number of bits processed as a unit.

RAM

i. It is Random Access Memory.

ii. It is a volatile memory.

iii. It helps the computer to boost up the processing speed.

iv. Range of RAM lies between 64 MB to 4GB or more.

v. It is very costly in price and its shape is rectangular
chip.

vi. It stores data temporary.

ROM

i. It is called Read-Only Memory.

ii. It is a non-volatile memory.

iii. Data stored in ROM cannot be deleted.

iv. They are also called permanent storage memory.

v. ROM is not used to boost the speed of long computer.

vi. It store data permanently.

Compiler : A compiler is a program that translates

human readable source code into computer executable

machine code. The compiler is only a program and cannot

fix your programs for you. If you make a mistake, you

have to correct the syntax or it won't compile.

Interpreter : This is a far faster process. It helps novice

programmers edit and test their code quicker than using a

compiler. The disadvantage is that, interpreted programs



run much slower than compiled programs. As much as 5-
10 times slower as every line of code has to be re-read,
then re-processed. For example. BASIC has an interpreter
as a translator.

Utility software is a computer software designed to help
in the management and tuning of operating systems,
computer hardware and application software. It is
designed to perform a single task or a multiple of small
tasks. Examples of utility software's include Disk
defragmenters, System Profilers, Network Managers,
Application Launchers and Virus Scanners.

Write the full form of the following :

nk W=

Central Processing Unit
Arithmetic Logic Unit
Liquid Crystal Display

Very Large Scale Integration
Ultra Large Scale Integration

Lesson 2 : Windows 7

Multiple choice question :

1. (a) 2. (b) 3.(d)

4. (a) 5.(a) 6. (¢)

7. (a)

Write ‘T’ for true and 'F' for false statements:

1. T 2.T 3.T

4.F 5.F 6. T

7. T

Fill in the blanks :

1. Operating System 2. GUI

3. run 4. Windows

5. button configuration 6. Regional setting

Answer the following questions in short :

1. An Operating System acts as an intermediate between the
user and the machine. It gives the framework upon which
all other services and applications run.

2. Search Option is a powerful tool. With the help of this
tool we can find the exact location of the items and all
folders.

3. The Run command in Windows is one of the most unused,

yet powerful feature in the operating system. Its main



purpose to open a program, folder, document, or Internet
resource, which Windows will then open.

Wildcards : '?" and '*' are used if the exact name of the
file you are searching is not known.

“?” represents one character or space.
“** represents more than one character or space.

E. Answers the following questions in detail :

1.

Three advantages of Windows as an Operating System
are :

Graphical User Interface : It is also known as GUI,
where the user clicks on a visual screen that has icons,
windows and menus, by using a pointing device, such as
a mouse.

Easy to use and learn : Working with Windows is easy
as it just requires a few mouse clicks to do your work.
Multitasking : It is processing multiple tasks at one time.
The Run option is the powerful feature in operating
system. It is accessible in one of two ways through start
menu or shortcut key (wintR) The run option opens the
file application when correct keyword is entered. It save
our time.

Search Option is a powerful tool. Search Option is
present in Start menu. With the help of this tool we can
find the exact location of the items and all folders.

For example : Suppose you wrote a document on your
computer. After few days, you wanted to see its content
again and suddenly you forgot the location where you
have saved the document. Then, with the help of this tool
you can find the exact location of your document.
Wildcards : '?" and '*' are used if the exact name of the
file you are searching is not known.

‘?” represents one character or space.

“*’ represents more than one character or space.

The Control Panel is centralized configuration area in
Windows. It is used to make changes to nearly every
aspect of Windows including keyboard and mouse
function, passwords and users, network settings, power
management, desktop backgrounds, sounds, hardware,
program installation and removal, speech recognition,
parental control, etc.



Using Display icon you can change the background,

screen saver, colours, font size and screen resolution. It

has tabs for changing the theme, desktop, screen saver,

appearance and settings.

Using Mouse Icon you can change the mouse setting such

as button configuration; double-click speed, mouse

pointer shape and motion speed and trails with the help of

the Mouse icon.

Using Regional Setting Icon you can change the setting

of the display of languages, numbers, time and date.

Regional Setting Icon can change the setting of the

display of languages, numbers, time and date.

“B Click on Start button > Control Panel > Regional
setting icon.

“B You will change in drop down icon, you will find the
changing in Samples.

“B  Short date, Long date short time, Long time and First
day of week is represented in the dialog box.

Y8 Click on Apply.

“B  Click on OK.

Arrange the steps to open On-Screen Keyboard :

kv

Click on the Start button.
Click All Programs.

Click on Accessories.

Click on Ease of Access.
Click on On-Screen Keyboard.

Lesson 3 : MS Word

Multiple choice questions :

1. (a) 2. (b) 3. (¢)

4. (d) 5. (¢) 6. (a)

7. (d) 8. (b)

Write ‘T’ for true and 'F' for false statements:

1.T 2. T 3.F

4. T 5.T 6. T

7.T

Fill in the blanks :

1. MS Word 2. top 3.Ctrl + Alt + F



4. Drop Cap 5. preset 6. non-printing

7. user 8. dictionary

Answer the following questions in short :

1.
2.
3.
4.

Ctrl + Alt + F
Ctrl + Alt + D
Ctrl + Shift + L
Shift + F7

Answer the following questions in detail :

L.

Tab key is used to give tabular space in between your

sentences or advance the cursor to the next tab stop.

To change its default shift’s

i.  Display home tab of ribbon.

ii. Click the icon at bottom right of paragraph group.
Word display Paragraph dialog box.

iii. Click Tab button. Word display Tab dialog box.

iv. Change the value in Default Tab stop control.

v. Click on OK.

Different margins available in Page Setup dialog box are :

Top, Bottom, Left, Right, Gutter and Gutter position.

Page numbering is the process of applying a sequence of

numbers (or letters, or roman numerals) to the pages. It

allow the citation of a particular page of the numbered

document. It facilitates to the reader to find specific parts

of the document and to known the size of the complete

text.

Footnotes and Endnotes document are used in printed

documents to explain, comment on, or provide references

for text in a document. We can insert footnote at the end

of a clause, sentence or at bottom of page. Endnotes are

inserted at the end of the document.

Yes we can insert page number using Header and Footer

option. The steps are :

i.  Select the header or footer. The design tab will appear.

ii. Place the insertion point where you want the page
number to be.

iii. From design tab, select the page number command.

iv. Click current position, then select the designed style.
The page number will appear in the document.



Answer in one word :

1. CPU 2. Program 3. Hardware
4. Monitor 5. Web addresses

Match the following :

1. (e) 2. (¢) 3. (©

4. (g) 5. (a) 6. (d)

7. (b)

Lesson 4: MS PowerPoint
Multiple choice questions :

1. (a) 2.(¢) 3. (b)

4. (d) 5. (¢)

Write ‘T’ for true and 'F' for false statements:

1.T 2.T 3.T

4. T 5.T

Fill in the blanks :

1. presentation 2. thumbnail 3. MS PowerPoint
4. arrow 5. easily 6. subtitle

Answer the following questions in short :
1. A PowerPoint template is a presentation from which new
presentations are based.
2. A template already contains formatting, fonts (typeface
and character size), and could contain other design
elements.
3. Create A New Presentation
i.  Click the File tab and select New Available Templates
and Themes on your computer and the Office. com
Templates site display.

ii. Double-click the default, Blank presentation icon to
open a new presentation based on this template. A
Blank presentation opens in a new window .

4. The Slide and Outline thumbnail views can be used to
enter, view, or move text or slides.

Answer the following questions in detail :

1. It is possible to create a blank presentation (void of
design elements) in order to select or add your own
design elements.

To Create A New Presentation :

i. Click the File tab and select New. Available
Templates and Themes on your computer and the
Office. com Templates site display.



ii. Double-click the default, Blank presentation icon to
open a new presentation based on this template. A
Blank presentation opens in a new window .

When new presentation is opened, a blank Title slide

appears by default as the first slide. You can start a new

presentation when you first open PowerPoint or after

PowerPoint is already open. PowerPoint lets you change

the appearance, layout and content of your presentation at

any time.

i.  Click the File tab and select New. Available templates
and themes display.

ii. Under Available Templates and Themes, click Blank
presentation one time to preview its title slide and see
how this template will look. A preview of the selected
Blank presentation template displays on the right-
hand side of the window.

iii. You will find View Templates for New Presentations.

iv. Under Available Templates and Themes, Click Recent
templates to view templates that have been used that
you might want to use again.

v. Click the Home button to return to the Available
Templates and Themes window .

vi. Under Templates, click installed Themes and view the
thumbnails.

vii. Choose a desired theme and click Create. The
selected theme is applied to the presentation.

viii.Click in the title and subtitle text boxes and type
desired presentation text.

Consider the following points when creating a

presentation.

Considerations

Purpose of the presentation

Audience

Room size and light

Equipment and software

Templates

Choose colour and a plain font (one to two fonts) that

will display well in the room(s) where the

presentation will be displayed.

On the Themes Gallery, click the Colors drop-down arrow
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to select from built-in color schemes or Create New
Theme Colors to create an entirely new theme or to
modify colours for specific areas. Fonts and Effects also
can be added or changed by using their corresponding
menus.

Arrange the steps to add a new slide :
1. (5) 2.(2) 3.(4)
4.(3) 5.(1)

Lesson 5 : MS Excel

Multiple choice questions :

1. (b) 2. (c) 3. (a)

4. (d) 5. (a) 6. (b)

7. (a)

Write ‘T’ for true and 'F' for false statements:

1. T 2. F 3. F

4. F 5.7 6. T

7. F

Fill in the blanks :

1. Excel 2. Formatting 3. modified

4. grid lines 5. grow font 6. standard

7. cells

Answer the following questions in short :

1. It adds up all the values in a range of cells. To use
addition we'll use the formula : = sum (number | +
number 2 + ........ )

2. It calculates the average of the cell values. To use average
we'll use the formula : = average (number 1, number 2,
number 3.... )

3. It counts the cells values. To use counts well use formula
: = count (cell range)

4.  Borden button is used to remove borders in a worksheet.

Answer the following questions in detail :

1.  Excel is a spreadsheet program in the Microsoft Office
system. You can use Excel to create and format
workbooks in order to analyse data and make more
informed business decisions. Specifically, you can use
Excel to perform various calculations and a variety of
professional looking chart.

2. Numbers entered in an MS Excel could be a value, data
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or time. You can choose the format of the digit by
following few steps :

1. Select the range of the cells that you wish to format.

ii.  Click on Home button.

iii.  Click on Format Cells or you can use Ctrl + Shift +
F.

iv.  You may choose to format numbers, data or time
from the Category section of the dialog box.

V. Formatting features appear on the dialog box,
depending upon the Category selected. Selected the
desired format.

vi.  Click on OK.

vii. Data in the selected range of the cells will now
appear in the selected format.

By Border Formatting we can change the style, Width,

and color of the borders, lines, and gridlines that we add.

Follow these steps to add cell borders :

i.  Select the cells you want to format.

ii. Click the down arrow beside the Borders button in
the Font group on the Home tab.

A drop-down menu appears, with all the border options

you can apply to the cell selection.

i.  Use the Borders button on the Home tab to choose
borders for the selected cells.

ii. Click the type of line you want to apply to the
selected cells.

To Change the Font Size

i.  Select the cells you want to modify.

ii. Click the drop-down arrow next to the Font Size
command on the Home tab. The Font Size drop-
down menu appears.

iii. Move your mouse over the various font sizes. A live
preview of the font size will appear in the worksheet.

iv.  Select the font size you want to use. You can also
use the grow font and shrink font commands to
change the size.

If the formula or a function is typed incorrectly an error

is displayed. Some common errors displayed in MS Excel

and their possible reasons are given as :
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Error message Possible reasons

displayed
HiHHH — The column is not wide enough to display
the result or the value.
#DIV/O! Division by zero error (invalid operation).
#N/A Data unavailable
#VALUE! Invalid data
#NAME! When text is not recognised
#REF! Invalid cell reference
#NULL Ranges do not intersect or the user is

using invalid range operator.
Rearrange steps to formatting numbers :
Select the range of the cells that you wish to format.
Click on Home button.
Click on Format cells or you can use Ctrl +Shift + F.
You may use choose to format numbers, data or time
from the Category section of the dialog box.
5. Formatting features appear on the dialog box, depending
upon the category selected. Selected the desired format.
6. Click on OK.
7.  Data will appear in selected format.

bl

Lesson 6 : Algorithms and Flowcharts
Multiple choice questions :

1. (b) 2. (¢) 3. (b)
4. (a) 5. (b)

Write ‘T’ for true and 'F' for false statements:

1. T 2. T 3. T
4. F 5. F 6. T
Fill in the blanks :

1. Processing box 2. graphical 3. flow chart
4. Connector 5. independent

Match the following :

1. (b) 2. (d) 3. (e)
4. (a) 5. (o)

Answer the following questions in detail :

1. An algorithm is a set of instructions given to computer to
solve any mathematical or logical problem. In short, it
may be defined as a step-by-step procedure to solve any
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problem. It is always written in simple Language and

precise so that anybody can understand it better.

We write a program on computer by following the given

three steps :

* Write an algorithm.

* Design a flowchart based on the algorithm.

* Conversion of flowchart into program.

Characteristics of an Algorithm are :

* Input : It has a well defined input.

* Output : It has a well defined output.

* Finiteness : It has a fixed number of steps which are
performed in time.

* Well-ordered : All the instructions are given in right
order.

* Unambiguous : Each and every step has a clear and
definite meaning without any ambiguity.

+ Effectiveness : It runs effectively in terms of memory
usage, resources used and the time.

Three advantages of an algorithm are :

(i) They are easy to understand and execute.

(ii)) They make the removal of any type of error easy

while solving out any problem.
(i) They give clear description of all the steps needed to
solve a problem.
Four different symbols used in a flow chart are :

Start or stop —
Input or Output Box £ —7
Processing Box 1
Decision Box &

Limitations of flow chart are :

(i) When the program logic is quite complicated, flow
chart becomes complex to understand.

(i) Designing a flowchart requires more space than
writing an algorithm.

(iii) If some modification are required, the flow chart may
require re-drawing completely.

Define the following :

1.

2.

Decision box : It is used to indicate some decision
making process on data.

Input or Output box : It is used to indicate the input or
output of data.



3. Processing box : It is used to indicate the processing of
data or some calculation.

4. Connector : It is used to connect the various sections of
a flowchart to maintain its linear flow.

Lesson 7 : Learning QBASIC
Multiple choice questions :

1. (d) 2. (a) 3. (b)

4. (a) 5. (¢) 6. (a)

7. (d)

Write ‘T’ for true and 'F' for false statements:

1. F 2. T 3. F

4. T 5. F 6. T

7. T

Fill in the blanks :

1. .BAS 2. Save 3. GW Basic
4. Status Bar 5. Menu 6. Program name
7. Exit

Answer the following questions in short :

1. Title Bar displays the name of the program running and
the file name.

2. The Menu Bar has the following main menus: File, Edit,
View, Search, Run, Debug, Options and Help. You can
select the desired menu with a mouse-click.

3. To Exit from the QBASIC, we can use the following
steps.

File menu > Exit option

4.  Program Area is the actual workspace where the program
is typed.

5. Vertical Scrollbar helps to scroll either to the beginning or
to the end of the screen.

Answer the following questions in detail :

1. The QBASIC is a programming language. BASIC stands
for Beginner's All-purpose Symbolic Instruction Code. It
belongs to the category of high-level programming
languages. In 1985, Microsoft released the version of
BASIC language called QBASIC with its MS DOS 5.0
operating system. It basically supports Character User
Interface (CUI).

®



The different components of QBASIC window are :

(i) Title Bar (i1)) Menu Bar

(iii)) Program Area (iv) Program name

(v) Horizontal Scrollbar (vi) Vertical Scrollbar

(vii) Status Bar (viii) Immediate Mode Area

The command 'CLS' stands for Clear Screen. It clears the
content on the screen. To start the program, we use CLS
command as the first line. This command can be used
anywhere in a program.

(i) To write a simple program we can use CLS and
PRINT.

CLS

A=3

B =4
PRINT A*B
END

(i1)) To execute or to run a QBASIC program click on
Run menu—>Start option or Shift+ FS

(ii1) The output screen occurs.

After writing a program you can store it in a secondary

storage device. If you are saving a file first time you can

use Save As option. You can give a name to untitled
program. The step in QBASIC is given here.

i. Click on File menu > Save As option.

ii. After clicking on the Save As option, a dialog box
appears. Give the suitable name to the file. Select the
location where you want to save the file.

iii. Click on OK.

iv. To save the changes in the existing program file, use
Save option from the File menu.

F. Define the following :

1.

2.

Status Bar : It displays the status of the current position
of the cursor.

Menu Bar : The Menu Bar has the following main
menus: File, Edit, View, Search, Run, Debug, Options and
Help. You can select the desired menu with a mouse-click.

Vertical Scrollbar : It helps to scroll either to the
beginning or to the end of the screen.

Title Bar : It displays the name of the program running



and the file name.

5. Immediate Mode Area : The mode in which a QBASIC
statement is executed as soon as Enter key is pressed.

6. Program Area : It is the actual workspace where the
program is typed.

7.  Horizontal Scrollbar : It helps to scroll either to the left
or the right on the screen.

8. Program Name : It is displayed just below the Menu bar.
By default it displays ‘Untitled’.

Lesson 8 : About E-mail
A. Multiple choice questions :

1. (b) 2. (b) 3. (¢)
4. (d) 5. (d) 6. (b)
7. (¢) 8. (b)

B. Write ‘T’ for true and 'F' for false statements:
1. T 2. F 3.7
4. T 5. T 6. F
7. T

C. Fill in the blanks :
Computer Network
Uniform Resource Locator
URL or E-mail address
E-mail
attachment
outgoing
7. viewing attachments
D. Answer the following questions in short :

1. Email means electronic mail. It is a fast and convenient
way to communicate with others via internet. You can
send and receive messages to any person with an email
address.

2. URL stands for Uniform Resource Locator.

3. DNS stands for Domain Name System. The DNS
translates Internet domain and host names to IP addresses.
DNS automatically converts the names, we type in our
Web browser address bar to the IP addresses of Web
servers hosting those sites.

4. Hostname is the name of the email server that provides

AN AN e
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5.

email services.

Your email address is stored on the mail server, you may
also receive some unwanted junk mails. These unwanted
messages are known as junk mails or spam mails.

E. Answer the following questions in detail :

L.

URL stands for Uniform Resource Locator. A URL is a
formatted text string used by Web browsers, email clients
and other software to identify a network resource on the
Internet.

URL strings consist of three parts :

i.  Network protocol

ii. Host name or address

iii. File or resource location

To send and receive your emails you need to create an

email account. This account can be accessed by using an

email address. This address is a combination of a

username and a hostname, and is written as

username@hostname. For example parv@hotmail.com,
samniceboyl@gmail.com.

Username : It can be any name given by the user.

Hostname : It is the name of the email server that

provides email services.

Advantages of Email are :

(i) One advantage of email over the telephone or
regular mail is its convenience.

(i) Your message is delivered instantly from your
computer to any other computer whether it is in
your locality or halfway around the world.

(i) Email is less expensive than telephone calls, faxes,
courier or postal service. In fact, it is free at times.
No stamp or paper cost is involved.

Limitations of Email are :

(i) Unwanted e-mails : Since your email address is
stored on the mail server, you may also receive
some unwanted junk mails. These unwanted
messages are known as junk mails or spam mails.

(i1))  You can secure your email accounts by entering a
password. However, if someone knows your
password, the person can easily access your account
and may read or send messages through it.

The Compose page is the page on which you can write



and address your outgoing E-mail messages. To access
the Compose page, click Compose in the left-side
navigation panel or click the email icon next to a name in
your address book.

We can say that email is inexpensive as it is less
expensive than telephone calls, faxes, courier or postal
service. In fact, it is free at times. No stamp or paper cost
is involved. The cost has nothing to do with distance, and
in many cases, the cost does not depend on the size of the
message either.

It is important to close your email account properly. It
ensures that no one else can access it without the
password. To sign out, you have to click on the Sign out
option present at the top right corner of the screen. This
will move you out of your account.

Match the following :

1. (d) 2. (¢) 3. (b)
4. (e) 5. (a)

Arrange steps to opening E-mail Account :

1. (2) 2. (4) 3. (5
4. (7) 5. (8) 6. (1)
7. 3) 8. (9) 9. (10)
10. (6)

Lesson 9 : World Wide Web

Multiple choice questions :

1. (a) 2. (a) 3. (a)

4. (d) 5. (a)

Fill in the blanks :

1. network 2. “HTTP://” 3. servers
4. TCP 5. information 6. services

7. individual person
Answer the following questions in short :

1.

HTTP is the standard protocol for transferring web pages
across the Internet. As soon as you browse a web page,
the URL is preceded by "HTTP://".

SMTP is a set of communication guidelines that allow
software to transmit email over the Internet. The other
purpose of SMTP is to set up communication rules
between servers.



There are millions of applications of the Internet and
World Wide Web helps you explore it and do many
activities online such as E-commerce, Education,
Entertainment, Streaming, media etc.

M-Commerce is the buying and selling of goods and
services through wireless and land held devices such as
cellular telephone or PDA’s.

E. Answer the following questions in detail :

1.

E-Commerce or Electronic commerce is online trading or
exchanging of goods, services and information. E-
Commerce allows consumers to electronically exchange
goods. There are several websites on the Web where you
can buy and sell products. These products can be
anything from a pen to a laptop or professional solution
or services. You can pay your utility bills like mobile,
landline, electricity, etc. online.

A protocol is simply a standard for enabling the
connection, communication, and data transfer between
two places on a network. Given below are a few
protocols that you experience on the web :

TCP/IP : Transmission Control Protocol/Internet Protocol
HTTP : Hyper Text Transfer Protocol

SMTP : Simple Mail Transfer Protocol

FTP : File Transfer Protocol

The components of the Web are given below :

Web client : This can be a laptop or a personal computer
in your home or at your office.

Web server : The term web server refers to either the
hardware or the software that helps to deliver Web
Content that can be accessed through the Internet.

Web browser : This is a software application in your
laptop or your PC which is used to access the information
from the Web.

Internet Service Provider (ISP) : It is a company that
offers its customers access to Internet. The ISP connects
to its customers using a data transmission technology
appropriate for delivering.

E-commerce : E-Commerce or Electronic commerce is
online trading or exchanging of goods, services and
information.  E-Commerce allows consumers to
electronically exchange goods. There are several websites



on the Web where you can buy and sell products. These
products can be anything from a pen to a laptop or
professional solution or services. You can pay your utility
bills like mobile, landline, electricity, etc. online.
Education : World Wide Web plays a major role in
education. Few basic education elements present on the
Web are :

* Online tutorials Web Publishing

* Online Forums

» Easy navigation from source to source.

The resources provided on various web pages are indeed
very informative and useful for professionals and students
related to every field of work. Internet has also provided
the opportunity to study online.

Entertainment : World Wide Web hosts millions of web
sites offering all types of contents for entertainment. You
can download songs, games, movies, etc. from the Web.
It is an action, event or activity that aims to entertain,
amuse and interest an audience of one or more people.
Email, blogs, chat rooms are also a source of
entertainment for some people.

Web hosting is the service that makes your website
available to be viewed by others on the Internet. A web
host provides space on its server, so that other computers
around the world can access your website by means of a
network or modem. There are literally thousands of web
hosting services available today, ranging from free
services with limited options to expensive, specialized
business web hosting services

Write the full form of the following :

NNk W=

Internet Service Provider
Simple Mail Transfer Protocol
Hyper Text Transfer Protocol
Electronic Commerce
Transmission Control Protocol
File Transfer Protocol

World Wide Web Consortium
World Wide Web



Class — VII

Lesson 1 : Network and Communication

Multiple Choice questions :

1. (a) 2. (b) 3. (¢)

4. (d) 5.(d) 6. (¢)

7. (b) 8. (a) 9. (a)

10. (¢)

Write ‘T’ for true and ‘F’ for false statements :

1.T 2.T 3.T

4. T 4. T 6. F

7.T 8. F

Fill in the blanks :

1. data 2. network 3. Hub

4. wireless transmission 5. primitive
6. homes 7. File server 8. Coaxial Cable

9. Network Adaptor 10. data
Answer the following questions in short :

L.

A computer network is a network that enables two or
more computers to share data and resources such as
printers,  exchange files or allow electronic
communications.

The advantages of computer network are :

(i) Speed

(i1) Cost Effective

(ii1) Security Concerns.

(iv) Centralised Software Management.

(v) Resource Sharing.

LAN stands for Local Area Network in which two or
more computers and peripheral devices are connected
within a small area, as in a room, office building or a
compus.

Network Interface card is a circuit board that regulates
exchange of data between the network and computers.
The advantages of Peer-to-peer architecture are :

(i) There is no need for full-time System Administrator,
every user is the administrator of his machine.

(i) User can control their shared resources.
Coaxial cable is the kind of copper cable that is suitable
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for transmitting signal of low power over a small distance.
They are used in Cable TV, etc.

Infrared is one of the most primitive forms of wireless
communication suitable for short distance communication.
For example : television and a remote control connect to
each other.

E. Answer the following questions in detail :

1.

Networking also known as computer networking, is the
practice of transporting and exchanging data between
nodes over a shared medium in an information system.
The advantages of networking are :

(1) Speed : This enables users to share and transfer files
within the same network and save time; while
maintaining the confidentiality of the file.

(ii)) Cost Effective : Computer networks save a lot of
cost for any organizations in different ways. This
helps to transfer files and messages to other people
which reduce transportation and communication
expense.

The disadvantages of connecting computers in a network

are :

(1) Users become dependent on them for example, if a
network file server develops a fault, then many users
may not be able to run application programs and get
access to shared data.

(i1) Viruses can spread to other computers throughout a
computer network.

(i) As traffic increases on network, the performance

degrades.

(iv) It is difficult to make the system secure from
hackers.

(v) Efficiency is dependent on the skill of the system
manager.

The different components of a computer network are :

(i) Client : These are computers that access and use the
network and shared network resources. Client
computers are basically the customers (users) of the
network as they request and receive services from
Servers.

(i) Server : Servers are computers that hold shared files,
programs, and the network operating system. Servers
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provide access to network resources to all the users
of the network.

(ii1) Workstation : A workstation is a computer intended
for individual use in a networking environment.

(iv) Network Interface Card (NIC) : It is also known as
Network Adaptor. It is a circuit board that regulates
exchange of data between network and computers.

(v) Transmission Channels : Each computer in the
network is interconnected through transmission
channel. These channels can be wired or wireless.
Data is exchanged between two computers through
these channels.

The physical arrangement of the cables, computers, and
other peripheral devices to form a network is known as
topology. Some of the network topologies are :
(i) Bus topology
(i1) Star topology
(ii1) Ring topology
For example : a multistory office building. The network
could consist of a bus running vertically through the
building to provide network access to each floor.
Peer-to-peer architecture is a networking architecture in
which each workstation, or node has the same capabilities
and responsibilities. It may also be used to refer to a
single software program designed so that each instance of
the program may act as both client and server. The
application of P2P network is content distribution that
includes software publication and distribution, streaming
media etc.

Advantages :

There is no need for full-time System Administrator,

every user is the administrator of his machine.

Disadvantages :

Security in this system is very less. Malwares such as

viruses, spywares etc. can easily be transmitted.

The different types of topologies for a computer network

are :

(i) Bus topology : It refers to a single cable that
connects all the workstations, servers, printers and
other devices on the network.

It is mostly used on Local Area Network (LANSs).



Advantages :

(a) Cable length required is the least.

(b) Bus topology costs very less.

Disadvantages :

(a) There is a limit on central cable length and number
of nodes that can be connected.

(b) Maintenance cost is higher.

(c) Security is very low and not suitable for networks
with heavy traffic.

(ii) Stat topology : This type of topology is where all
the computers and devices on the network connect to
a central device, thus forming a star. The central
device that provide connection is called hub.

Advantages

(a) Its simplicity obviates the need for complex routing
or message passing protocols.

(b) Isolation and centralization allows it to simplify fault
detection.

Disadvantages

(a) High dependence of the system on the functioning of
the central hub.

(iii) Ring topology : In this, all the nodes are connected
to one another in such a way that they make a closed
loop. Data travels around the network, in same
direction.

Advantages :

(a) Performance is better even when the load on the
network increases.

Disadvantages :

(a) This is slower than Star topology as each packet of
data must pass through all the computers between
source and destination.

(b) Network highly dependent on the wire which
connect different components.

Servers are computers that hold shared files, programs,

and the network operating system. Servers provide access

to network operating system. Servers provide access to
network resources to all the users of the network.

This is the administrator that controls functioning of the

computer.
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For example : A uses may set up a server to control
access to a network, send/receive e-mail, manage print
jobs, or host a website. They are also proficient at
performing intense calculations.

There are many different types of servers, for example :
File server : a computer and storage device dedicated to
storing files.

Print server : a computer that manages one or more
printers.

8. In wide Area Networks (WAN) and Metropolitan Area
Networks (MAN), a ring topology is used to as the
topology for the backbone (sometimes called a city ring)
to connect the customers.

Write the full form of the following :

Wide Area Network

Transmission Control Protocol

Simple Mail Transfer Protocol

Network Interface Card

Local Area Network

Metropolitan Area Network

Hyper Text Transfer Protocol

File Transfer Protocol

Internet Protocol

0. Wireless Fidelity

i Al S e

Lesson 2 : Windows Explorer
Multiple Choice Questions :

1. (a) 2. (b) 3. (a)
4. (d) 5. (b)

Write ‘T’ for true and ‘F’ for false statements :
1.T 2.F 3.T
4.F 5.T

Fill in the blanks :

1. Left Pane, Right Pane

2. Content Icons 3. Searching

4. Calc 5. Cul +X

Answer the following questions in short :

1. There are two panes available in Windows Explorer they
are :

(i) Left Pane  (ii) Right Pane.



The parts of window explorer are :

(1) Title bar

(i1) Back and forward buttons

(ii1) Address Bar (iv) Search Box

(v) Menu bar (vi) Tool Bar

(vii) Status bar

We can create a new folder with the use of keyboard by

pressing : Ctrl + Shift + N keys together.

Steps to copy items using copy and paste are as follows :

(1) Select the items you want to copy.

(i) Choose copy from the edit or context menu or press
Ctrl + C Keys.

(iii) Specify your destination to paste files.

(iv) Choose paste from the Edit menu or press Ctrl + V
to paste the items. Your item will be pasted.

A background may refer to any i.e. :

(i) When referring to multitasking operating systems,
the background is the place on active program is
running, but not visible to the user.

(i) A background is also another way of describing the
Microsoft Windows wallpaper.

A screen saver is a software program that becomes

activated after the computer is not in use for a specified

duration of time. It consist of an animated image.

Answer the following questions in detail :

L.

Windows Explorer is an important application of
operating system. It is also known as file explorer. It is
used to view files and folder that is in our computer. It
helps in opening files, deleting files and folders, renaming
them, copying and moving them around, and creating new
folder. It provides a graphical interface to navigate hard
disk or other media that is connected to our computer.
There are number of ways to open windows explorer.
They are :
(i) Press Windows Key+ E button together OR
ii) Press Window Key

Click on All Programs

Accessories

Windows Explorer

OR
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(iii) Press windows key

Type “Explorer” in search Box and Press Enter
OR

iv) Press windows key + R together — Run box will
open Type Explorer in Run box and press Enter.

(v) By default windows explorer button is located at
second on Taskbar. So Press Windows and 2 keys
together.

Each location has a view setting and this determines the

layout of the items on the screen and the sort of

information which is displayed for each item.

(i) Small, medium, large and extra large icon view the
items are loud out as one or more rows, and each
item consist of an icon with its name.

(i) Title Icon view : The items are laid out as one or
more rows, and each item consist of an icon. Each
item contains a name. It has some other information
like type of file and size.

(ii1) List Icons view : The items are laid out as one or
more columns and each item consists of a name,
with a small icon just to its left.

(iv) Details Icons view : Each item consists of a row in a
table. The first column contains a name, together
with a small icon, and the other columns contain
various properties such as size and date modified.
Content icons view : The items are laid out
columnwise. Each item consists of an icon. It has a
name and type of item is written below. This view is
used by default for searches.

The steps of moving an item using cut and paste are as

follows :

(i) Select the item you want to cut.

(i) Choose cut from Edit menu or Press Ctrl + X key
from key board.

(iii) Specify your destinations to paste file.

(iv) Choose paste option or Press Ctrl + V Keys.

Now cut item will be pasted.

The step of copying items using send to option are as

follows :

(1) Select the items you want to copy.



(i)

(@)
(b)

(©)

Press right button of your mouse, you will see a
dialog box. Choose send to option and select your
required place. By default, the send to sub menu
contains the following destinations :

(a) Compressed (Zipped) folder,

(b) Desktop (Create shortcut)

(c) Documents library

(d) Fax and Mail recipients

(e) Devices with removable storage.

Run command is used to run a program directly
without going into a long way of selecting options.
Search command is used to find files or folders
without going into a long way of searching one by
one or different folders.

Calculation is a simple program. It is quite similar to
commonly used calculators for calculations.

Steps to change background are :

(1)
(i)

Choose any option from Pictures Locations.

All Background of your selected theme are selected
by default. If you want to use a single background
then click on clear all button.

(iii) To use your desired background click on top left

corner.

(iv) For picture position click on Picture Position and

™)

choose an option as per your choice.

If more than one Background are selected, to change
all automatically after some time click on change
picture every option and select time as per your
choice.

(vi) Click on save changes button. Desktop Background

is set to your choice.

Steps to set screen saver are :

(1)
(i)

Click on Screensaver thumb nail. You will see
various options.

To set screen saver of your choice click on Screen
saver button and select a screen saver of your choice
from drop down menu.

(iii) For Screen saver settings click on settings button

and set setting as per your choice.

(iv) To see preview of your screen saver click on

Preview button.



(v) To run a screen saver automatically on your desktop
we need to adjust its time. To do this click on Wait
Option and type time settings as it is set to 10
minutes.

(vi) Click on Apply button and then on OK button.
Screen saver will be set.

Lesson 3 : Ms Excel Advanced Features
Multiple Choice Questions :

1. (d) 2. (¢) 3. (b)

4. (a) 5. (¢) 6. (a)

7. (d) 8. (¢) 9. (a)

10. (b)

Write ‘T’ for true and ‘F’ for false statements :

1.T 2.F 3.T

4. T 5.T 6.T

7. F 8. F 9.F

10. T

Fill in the blanks

1. MS Excel 2. columns 3. null

4. absolute 5. comparison 6. decimal
7. absolute 8. text cells 9. cell address

10. concatenation.
Answer the following questions in short :
1. Excel uses four types of operators. They are :

(1) Arithmetic (i1) Text
(ii1) Comparative (iv) Reference.

2. Roundup ( ) function rounds a number up away from 0
(Zero).

Syntax ROUND UP (number, num-digits)
Where number is the number you want to round.
Num — digits specifies the number of digits to which you
want to round a number.
Example : ROUND UP (3.2 7, 1) equal 3.3
ROUND UP ( -1.475, 0) equal — 2
ROUND UP (31.5, — 1) equals 40
3. ABS () function returns the absolute value of a number.
The absolute value of a number is the number without
any + or — sign.



Syntax : ABS (num)

SQRT () returns a positive square root of a number
Syntax : SQRT (num)

A cell is the intersection of a row and column. Each
rectangle in a worksheet is called a cell. Each cell has
name, or a cell address based on which column and row it
intersects.

To compare values we can create formulas using
comparison operators. These operators return a True or
False result.

Operator Type

= Equal to

<= Less than or equal to

< less than

> Greater than

> = Greater than or equal to

< Not equal to

Example : A 12 < 15

True if the content of cell A12 is less than 15; False if the
content of A12 is 15 or more.

E. Answer the following questions in details :

1.

Cells are formed by the intersection of rows and columns.
They are identified by rows and column names. Rows are
numbered 1, 2, 3, 4 and Columns are named A, B, C, D
and so on. In Excel, a cell reference identifies the location
of a cell or group of cells in the spreadsheet. Cell
reference is also known as cell address. There are three
types of cell reference :

(i) Relative Reference

(i1)) Absolute Reference

(ii1)) Mixed Reference.

MS-Excel is a software that allows you to organize data
into rows and columns in a worksheet. It can also
perform calculations like addition and subtraction on the
data given in these rows and columns very fast. This
feature of MS-Excel is very useful, especially in financial
applications. It is also very helpful for management of
exam records.

Text Concatenation Operator i.e. the ampers and (&)
operator, joins text within quotation marks or text
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Operator

Space

contained is referenced cells. Joining text is known as
concatenation.

Example : Suppose we have Mr. in A1 and Parvin C1
Operator &

Formula=A1 & “” & C1

Result : Mr. Parv

Type of Operation : Text in Al and Cl1 is joined.
Reference Operator makes no changes to constants or cell
contents. Instead, they control how a formula groups the
cells and ranges of cells when the formula is made to
calculate.

Example Type Result
SUM
(A7 : Al1) Range Evaluates a single

reference the cells in the
rectangular area between
the two corners.
SUM
(A7 : All, B11) Union Evaluate two references
as a single reference.
SUM (A9 : Al1, A7 : Al11)  Evaluates the cells
common to both
references (if no cells
and common to both then
# Null results).
Mathematical functions are used to perform wide variety
of simple or complex calculations such as totaling the
value for a range of cells, rounding of a number etc.
Few Mathematical functions :
(@ Sum():
Add all the number in a range of cells.
Syntax : SUM (number 1, number 2)
(b) Round ():
It rounds a number to a specified number of digits.
Syntax : Round (number, num—digits)
(c) ABS() :
It returns the absolute value of a number.
Syntax ABS (num)
(d) SQRT () : It returns a positive square root of a
number.
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Syntax : SQRT (num)
Example : (i) SQRT (36) equals 6
(i1)) ABS (- 5) equals 5

6. To select a cell

(i) Click on cell to select it. When a cell is selected you
will notice that the borders of the cell appear bold
and the column heading and row heading of the cell
are highlighted.

(i1)) Release your mouse. The cell will stay selected until
you click on another cell in the worksheet.

(i) You can also navigate through your worksheet and
select a cell by using the arrow keys on your
keyboard.

7. A mixed cell reference is either an absolute column and
relative row or absolute row and relative column. When
you add $ before the column letter you create an absolute
column or before the row number you create an absolute
Tow.

For example : $§ A is absolute for column A and relative

for row 1, and A $ 1 is absolute for row 1 and relative for

column A.
Write Syntax for the following : ~ T B
1. SUM (number 1, number 2.....) 1. 4
Example : = SUM ( B1 B2, B3) equals 17 i: 130
2. PRODUCT (number 1, number 2, ............... )
Example : PRODUCT (B1, B2) equal 12
3.  EXP (number)
Example : = EXP (1) equals 2.718 28183
Chapter 4 : MS Access
Multiple Choice Questions :
1. (d) 2.(a) 3. (a)
4. (a) 5.(d) 6. (c)
7. (b)
Write ‘T’ for true and ‘F’ for false statements :
1.T 2. F 3.T
4. F 5.F 6. T
Fill in the blanks :
1. Data 2. columns 3. DBMS
4. non programmers 5. Open 6. bottom
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D. Answer the following questions in short :

1.

A Database is an organised collection of information and
records. It helps us to manage and access large amount of
information quickly and efficiently Example : a dictionary,
address books.

Database Management System (DBMS) is a software that
provides all the necessary tools to user to help him
organise data into a database. It provides facilities to add,
modify or delete data from a database, query the database
about data & produce refort. For example : Microsoft
Access, Oracle etc.

Table is a collection of related information in the form of
rows and columns, Rows are known as record and
column as field. All data is stored tables while report
present data from a table or query in a printed formation.
MS Access 2010 is a pseudo-relational database
management system from Microsoft that combines the
relational Microsoft Jet Database Engine with a graphical
user interface and software development tools.

Steps to start MS Access are :

(i) Click on the Start button.

(i) Click on all Programs.

(ii1) Select Microsoft Office 2010.

(iv) Click on Microsoft Access 2010.

(v) Access opens up.

E. Answer the following questions in details :

L.

The structure of a database is mode up of fields, records
and tables.

Field : A column within a table that contains only single
piece of information is known as field. For example, in a
table, Name, Date of Birth and City are the different field
names.

Record : The complete set of fields is called a record. All
the names in the column are record.

Table : It is collection of related information in the form
of rows and columns. Rows are known as record and
column as field.

Name Date of birth City
Priya 19 December Meerut
Mohit 16 June Delhi



2.

Advantages of DBMS are :

(@)

(ii)
(iif)
(iv)

V)

It reduces the data redundancy i.e. duplication of
data.

In DBMS, Certain standards can be applied in data
representation.

DBMS allows data sharing i.e. data can be shared
among multiple users.

It provides data security and thus ensures that the
only means of access to the database is through an
authorized channel.

DBMS provides backup and recovery subsystem that
is responsible for recovery from handware &
software failures.

To create a new database, we follow the following steps :

(1)
(ii)
(iii)
(iv)
(v)

Open the Microsoft Access 2010 program.

Click on New Blank Database. Click on Start from
Start Menu.

Click on All programs.
Click on Microsoft Office.
Click on Microsoft Office Access 2010.

The parts of MS Access Database Interface Window are :

(1)
(i)

(iii)
(iv)

V)
(vi)

Title bar : It displays the names of database.

Access Ribbon : It consist of a row of task such as
Title, Home, Create, External Data and Database tool.
The Status Bar : It display information about object
selected.

Scroll Bar : It is window component that enables a
user to navigate through different portions of an
object.

Navigation Pane : It displays list of objects available
in database.

Access Work Area : It display and enables the use of
database objects such as tables, forms & reports.

To Create a new table in an existing database :

1)
(ii)
(iii)

Click on the Microsoft Office button, and then click
on open.

In the open dialog box, select the database that you
want to open, and then click open.

On the Create tab in the Tables group, click on Table.
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(iv) Select Table Design option from the Tables group on
create tab shown.

(v)  You will see the table designation windows appears.

(vi) Enter fields name and its data type.

(vii) Save the table either by pressing Ctrl + S keys
together or choosing Save option from the office
button, type the name of the table in Save As box
and press Ok button.

Some major components of MS Access database are :

(i) Tables : They store information in the form of rows
(records) and columns (fields).

(i1)) Queries : They are basically questions based on the
data of the database. They allow you to extract data
or information about field, records and summaries of
the table or database.

(i) Forms : Forms are the input screens designed to
simplify the data entry process.

(iv) Reports : These present data from a table or query in
a printed format.

(v) Pages : Pages are used to add, view and edit data of
the tables.

(vi) Macros : They help you to perform routine tasks by
automating them into a single command.

(vii) Modules : Modules are the collection of programs
written to access the database.

Define :

L.

2.
3.

A column within a table that contains only single piece of
information is known as a field.

The complete set of fields is called a record.

It is a collection of related information in the form of
rows and columns .

Queries : They are basically questions based on the data
of the database. They allow you to extract data or
information about field, records and summaries of the
table or database.

Macros : They help you to perform routine tasks by
automating them into a single command.

Modules : Modules are the collection of programs written
to access the database.

Forms : Forms are the input screens designed to simplify
the data entry process.



With the help of clues, write what they are meant for :
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Y

components of a computer system.

is known as field.

is called a record.

is independent of the application programs.

can also be placed on a network and multiple users can
share and update the data.

at the bottom of Access Window.
add, view and edit data of the tabes.

Lesson 5 : MS Word Using Mail Merge

Multiple Choice Questions.

1. (a) 2. (b) 3. (¢)
4. (a) 5. (d) 6. (b)
7. (c) 8. (a)

Write ‘T’ for true and ‘F’ for false statements :
1I.T 2. T 3.T
4. T 5. T 6. F

Answer the following questions in short :

1.

Mail Merge is a mass mailing facility that takes names,
addresses and pertinent facts about recipients and
manages the information into the form of a letter.

We use 6 steps to complete mail merge.

After clicking step by step Mail Merge Wizard the Mail
Merge Dialog windows opens in which we have to select
document type like : Letters, E-mail, Envelopes, Labels,
Directory.

Current document means : Start from the document
shown here and use the Mail Merge wizard to add
recipient information.

Answer the following questions in details :

L.

Mail Merge is a mass-mailing facility that takes names,
address and pertinent facts about recipients and manages
the information into the form of a letter.

Mail Merge printing uses two files : a data file that
contains a listing of data items (or fields) arranged in
some specific order and a master file that contains
standard text and data variables.
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Mail Merge helps to create any type of printed documents

as well as electronically distributed documents and faxes.

The kinds of documents you can create using a mail

merge are virtually limitless.

Example : Labels, Envelopes.

Mail Merge group offer five choice— Creating Letters, E-

mail, Messages, Envelopes, Labels and Directory. The

mail merge process involves taking information from one

document, known as the data source, combining with

another document known as the main document. The

main document can be a form letter, labels, E-mail or

directory.

Do yourself.

The benefits of Mail Merge are :

(i)  Easy to make a change to a single letter and for that
change to happen in every letter.

(i1))  Letters can be personalised.

(ii1) Thousands of letters can be produced very quickly.

(iv) This feature saves your time and efforts.

Place six steps to create a merged documents :

(1)
(ii)
(iii)
(iv)
V)
(vi)

Select the document type
Select starting document
Select recipients

Write your letter
Preview your letters
Complete the Merge

Lesson 6 : Photo Shop : Basic

Multiple Choice questions :

1. (a) 2. (b) 3. (¢)

4. (a) 5.(d) 6. (d)

7. (b) 8. (a) 9. (a)
10. (d)

Write ‘T’ for true and ‘F’ for false statements :
1.T 2.F 3.T

4. T 5.T 6. F
7.T 8. F

Fill in the blanks :

1. Lasso 2. Brush 3. Stamp



4. Gradient 5. Dodge 6. Text

7. Selection 8. Zoom 9. grid of pixels
10. Zoom
D. Answer the following questions in short :

1. Adobe Photoshop is a professional image editing software
package that can be used to create a new image or modify
an existing one.

2. Vector images are comprised of paths, which are defined
by a start and end point, along with other points, curves
and angles along the way. Vector graphics are not made
up of grid of pixels. A path can be line, a square. a
triangle or curvy shape.

3. A bitmap is a map of dots, or bits because these images
are made up of a bunch of dots.

It appears to be very block when zoomed.

4. There are three types of Lasso tools : They are :
(i) Free-hand Lasso Tool
(ii)) Polygonal Lasso Tool
(ii1) Magnetic Lasso Tool.

5. JPEG is a format of save & open file. JPEG files are of
very small size but very poor quality too. JPEG stand for
Joint Photographic Experts Groups.

6. Selection Tools allow you to select areas in various
different ways. There are three main types of selection
tools : Magic Wand, Marquee and Lasso.

7. The Lasso Tool allows the free-hand selection of a part of
the image.

8. When you select layers using keyboard shortcuts while

recording an action then it is recorded in the action as a
forward or backward selection instead of a fixed layer
name. Here are few shortcuts for selecting layers :

Alt— [ = select the layer below the currently
selected layer (select backward)
Alt — ] = select the layer above the currently

selected layer (select forward).

E. Answer the following questions in detail :

1.

There are two types of images created in Photoshop :

(i) Bitmap images : A bitmap is a map of dots, or bits
because these images are made up of a bunch of dots.
It appears to be very block when zoomed.



(i) Vector images : Vector images are comprised of paths,
which are defined by a start and end point, along
with other points, curves and angles along the way.
Vector graphics are not made up of grid of pixels. A
path can be line, a square. a triangle or curvy shape.

Resolution is measured in terms of number of pixels or

dots per inch. In high-resolution image, the pixels are

more closely placed, we. there are (300) more pixels per
inch. It occupies more computer memory.

The three different modes that we can choose from in

Photoshop are :

(i) RGB : Photoshop RGB color mode uses the RGB
model, assigning an intensity value to each pixel. In
8 bits-per channel images, the intensity values range
from 0 (black) to 255 (white) for each of the RGB
(red, green, blue) component in a color image.

(i) CMYK Color mode : In CMYK mode, each pixels
is assigned a percentage value for each of the
process inks. The lightest colors are assigned small
percentages of process ink colors.

(ii1) Grayscale mode : It uses different shades of gray in
an image. In 8-bit image, there can be up to 256
shades of gray. Each pixel of a grayscale image has
a brightness value ranging from 0 (black) to 255
(white).

There are three selection tools in the Photoshop toolbox.

They are :

(i) The Magic Wand Tool : This tool allows you to
select areas of images based on color similarities
without having to trace its outline.

(ii)) The Marquee tool : It allows you to select rectangle
ellipses and 1. pixel rows & columns. The portion
over which it is dragged gets selected.

(ii1)) The Lasso tool : This tool allows free hand selection
of a part of the image.

Photoshop uses the foreground color to paint, fill and
stroke selections and the background color to make
gradient fills and fill in the erased areas of image. The
foreground and background colors are used by some
special effect filters. The default foreground color is black
and the default background color is white.



6. To create a new file, we will have to follow some steps :
(i) Click on New from the File menu.

ii) A dialog box opens up for where you need to select
or provide apporiate values for the following
parameters :

(a) Name : It allows to give name to your file.

(b) Size : Photoshop offers many preset size options
to choose from and even you can specify your
own size.

(¢) Resolutions : It is measured in terms of no. of
pixels or dots per inch.

(d) Mode : There are different color options to
choose such as RGB mode, (CMYK) mode etc.

7.  The Magic Wand Tool allows you to select areas of
images based on color similarities without having to trace
its outline.

The Marquee tool are selection tools which allow you to
select rectangles, ellipses and pixel rows and columns.
The portion over which it is dragged gets selected.

Click and hold the Marquee tool to see four options :
Rectangle Marquee tool

Elliptical Marquee tool

Single Row Marquee tool

Single Column Marquee tool

Lesson 7 : More on Photoshop.
A. Multiple Choice Questions.

1. (¢) 2. (b) 3. (¢)
4. (a) 5.(d) 6. (d)
7. (b)

B. Write ‘T’ for true and ‘F’ for false statements :
1.T 2.F 3.T
4. T 5.F 6. F
7.F 8. T

C. Fill in the blanks :
1. Path selection (A) 2. Horizontal Type tool
3. Rectangle 4. Line Tool



5. Quick Mask 6. Mask
7. Channels
Answer the following questions in shorts.

L.

2.

A clipping mask is a group of layers to which a mask is
applied.
Step to Group and Ungroup layers are :
(1) Select multiple layers in the Layers panel.
(ii)) Do one of the following :
Choose Layer > Group layers
Alt-drag (Windows) or Option-drag (Mac OS) layers
to the folder icon at the bottom of the Layers panel
to group the layers.
(ii1) To Ungroup the layers, select the group and choose
Layer > Ungroup Layers.
The first step is accessing channels by choosing Window-
Channels. The Channels panel appears. Selecting a
channel in the Channels panel automatically makes it
appear in the image window.
Quick mask made lets you edit any selection as a mask
without using the Channels palette and while viewing
your image.
The ‘Horizontal Type Masking tool” is used to mask the
background image into the text typed horizontally while
the “Vertical type Masking tool” is used to mask the
background image into the text typed vertically.

Answer the following questions in detail :

1.

The Drawing and Type tools create and alter vector
objects. Drawing tools work on vector paths, which are
vector-based outlines you can turn into selections. Using
the options bar, choose whether to draw paths or shape
layers. Type is created in type layers that can be
transformed worked and even set along paths.

The advantage of editing your selection as a mask is that
you can use almost any tool or filter to modify the mask.
In Quick Mask mode, Photoshop automatically defaults to
Grayscale mode.

The foreground color defaults to black, and the
background color defaults to white.

When using a painting or editing tool in Quick Mask
mode, keep these principles in mind :



(i) Painting with white erases the mask (the red overlay)
and increases the selected area.

(i1) Painting with black adds to the mask (the red
overlay) and decreases the selected area.

(ii1) Painting with gray lighter areas are more subject than
darker areas.

4. To create a Transparent Gradient in Photoshop :

(i) Create a Photoshop file with two layers — One
blank and the other containing the image to be made
transparent. Select the image’s layer.

(ii) Click the Add layer mask icon at the bottom of the
layer’s palette.

(ii1)) A layer mask is created in the image layer.

(iv) Select the gradient tool and apply a black/white
gradient to the image layer.

To add layers to a group do one of the following :

(i) Select the group in the Layers panel and click the
Create a New Layer button.

(i) Drag a layer to the group folder.

(iii) Drag a group folder into another group folder. The
group and all of its layers move.

(iv) Drag an existing group to the New Group button.

Lesson 8 : HTML
Multiple choice questions :

1. (d) 2. (d) 3. (a)

4. (c) 5. (a) 6. (b)

7. (b) 8. (b)

Write ‘T’ for true and ‘F’ for false statements :

1. T 2.T 3.T

4. T 5.F 6. F

7. T 8. T

Fill in the blanks :

1. Hyper Text Markup Language 2. .html
3. text 4. container 5. HTML
6. Heading 7. <br> 8. First tag.

Answer the following questions in shorts :

1. A container tag in HTML is one which has both opening
and closing tags. For example : <B> ............. </B> etc.



HTML tag tells the browser that this is an HTML
document. HTML tags denote various elements in an
HTML document.

WYSIWYG stands for What You See Is What You Get
This editor provides a graphical interface which has
various tools to help you create web pages without having
to write HTML tags.

Example : Adobe Dreamweaver.

An empty tag in HTML is one which has only an opening
or a start tag and no closing tag. For example <HR>.

A markup language is a computer language that uses tags
to define elements within a document.

For example : HTML

Answer the following in questions detail :

1.

HTML stands for hyper text markup Language. It is
simple scripting language, mainly used for developing or
creating electronic documents called pages or web pages
that are displayed on the World Wide Web. A web page is
a document containing text, pictures audio, video etc.
HTML is a collection of tags to design the page layout
and hyperlinks.

The content typed along with the start tag and the end tag
is called the HTML element. For example <B> Click
Start </B) is one HTML element.

HTML can also have nested elements.

Attributes of a tag provide additional information about
HTML elements. They are always written in the start tag.
Attributes appear as an attribute name followed by an * =’
sign and then its value.

For example : < IMG align = “left”).

Here, align ‘left” is an attribute of HTML element. ‘align
is the attribute name whereas “left” is an attribute value.
HTML tags.

Tags are used to mark up the start and end of an HTML
element.

A start tag consist of opening angle bracket (<) followed
by the element name, zero or more space separated
attribute/value pairs, and a closing angle bracket (>).

For <b> text </b> (writes text as bold)
HTML tag attributes.



Attributes of a tag provide additional information about
HTML elements. They are always written in the start tag.
Attributes appear as an attribute name followed by an * =’
sign and then its value.

For example : < IMG align = “left).

Here, align ‘left” is an attribute of HTML element. ‘align
is the attribute name whereas “left” is an attribute value.
WYSIWG EDITOR

Attributes of a tag provide additional information about
HTML elements. They are always written in the start tag.
Attributes appear as an attribute name followed by an * =’
sign and then its value.

For example : < IMG align = “left”).

Here, align ‘left” is an attribute of HTML element. ‘align
is the attribute name whereas “left” is an attribute value.
HTML tags.

Text Editor

Text Editor is a text based HTML editor, where we
manually type in the code. It allows the user to directly
edit the HTML with no visual guide. For this knowledge
of HTML tags is required.

For example : Notepad.

F.  Give the tag and attributes of the following Instructions :

1.

2.
3.

4

<htmlI>

<head>

<title> Title of the document </title>
<head>

<body>

The content of the document ...
</body>

</html>

<p align= “left |[right|center|justify>
<title> My Web World </title>

<font colour="blue”> This is some text! </font>

G.  What are the following HTML tags used for :

1.
2.
3.

<HEAD> 1t is used for giving heading for a web page.
<Title> tag is used to specify the title of the content.
<P> tag is used to create paragraph.



hd

= 0 0 =3

<BR> tag is used to break line.

<HR> tag is used to insert a horizontal rule or a thematic
break in an HTML page to divide or separate document
sections.

<B> tag allow to writes text as bold.

<SUP> tag lifts text and make it smaller.
<SUB> tag lowers text and makes it smaller.
<COLOR> tag specify the colour.

<FONT> tag specify the font or text format.

Lesson 9 : Internet & Search Engine

Multiple Choice Questions :

1. (a) 2. (b) 3.(c)

4. (d) 5. (a) 6. (b)

7. (¢) 8. (d)

Write ‘T’ for true and ‘F’ for false statements :
1.T 2. T 3.T

4. F 5.T 6. T

7.F 8. F

Fill in the blanks.

1. Internet 2. applications 3. three
4. communicate 5. interlinked 6. e-mail

7. name, password 8. word.
Answer in short :

1.

2.

ARPANET stands for Advance Research Project Agency
Network.

The World Wide Web is based on these technologies :

(i) HTML—Hyper Text Markup Language.

(i1)) HTTP—Hyper Text Transfer Protocol

(ii1) Web servers and Web browsers.

Researcher Tim Berner Lee led the development of the
original World Wide Web in the late 1980s and early
1990s.

Composing an e-mail message is just like writing a note
in word processor. It helps us to send messages to various
recipients.

Modem is a device that connects to your computer with
the telephone line. It changes the computer signals so as
to travel through telephone lines and vice versa.



6. A chat room is an area on the Internet or other computer
network where users can communicate through instant
messaging.

E. Answer the following questions in detail.

1. The Internet is a massive public spider web of computer
connections. It connects personal computers, mainframes,
cell phones, GPS units, music players etc. All of these
exist for the sake of free information sharing.

The Internet is a network of interlinked networking

worldwide which is accessible to the general public.

These interconnected computers work by transmitting

data through a special type of packet switching which is

known as IP or internet protocol.

World Wide Web is a popular service on the internet that

consist of all websites.

2. E-commerce stands for Electronic Commerce. The buying
and selling of products and services by businesses and
consumers through an electronic medium without using
any paper documents. It is subdivided into three
categories : business to business, business to consumer
and consumer to consumer.

3. The Internet Service Provider (JSP) is a company that
give you access to the Internet for a fee. The browser will
not be able to display images unless the computer is
connected to an ISP.

For eg. BSNL, Sify, Airtel, Reliance etc.

4.  The different ways to see a site are :

(1) Type the web address in the Address bar.

(i1) The drop-down arrow button to the right of Address
bar opens a list of recently visited web-sites. Click
on anyone to visit that website.

(i) The History button shows you the record which has
been seen by over the past four weeks.

(iv) After visiting several sites in the current session, you
can click the drop-down arrow next to the Back
button to jump up to nine of the most recently
visited sites. Click the Back button to browse back
through recently visited web pages, one at time.

5. The features of Electronic Mail are :

(i) E-mail is the fastest way of sending mails.



(ii)) The cost of sending an e-mail is very less.
(i) The postal address details have been replaced by e-
mail address.
(iv) Same message can be sent to a number of persons
without any additional cost.
(v) We can attach photos, videos etc along with our
message.
The website which provide the e-mail facility are :
www.hotmail.com
www.gmail.com
www.yahoo.co.in
www.rediffmail.com.
A web search engine is a software system that is designed
to search for information on the World Wide Web. The
search results are generally presented in a line of results,
often referred to as search engine result pages. We can
search and find any information whatever we want,
whether it is about websites, images, etc. Few exclusive
websites searching information are : www.yahoo.com,
www.google.co. in on www.bing.com.

Unscramble the given words :

1. PRINT 2. REFRESH 3. BACK
4. FORWARD 5. 6. HOME
Number the given steps :

ARl S e

Creating an E-mail account.
Sign in to your account.
Compose the mail.

Click on Send button.

Sign out from your account.



Class — VIII

Lesson 1 : Computer Memory
Multiple choice questions :

1. (¢) 2. (a) 3. (b)

4. (¢ 5. (a) 6. (b)
Write ‘T’ for true and 'F' for false statements:

1. T 2. T 3. T

4. F 5. F

Fill in the blanks :

1. bit 2. single character 3. motherboard
4. daughter board 5. read 6. capacity
Match the following :

1.  Primary memory RAM

2. Chipset silicon

3. Megabyte 1024 KB
4.  Secondary memory Hard Disk
5. Kilobyte 1024 byte
6. Byte 8 bits

Answer the following questions in short :
1.  Primary memory is of two kinds :
(i) RAM (Random Access Memory)
(i1)) ROM (Read Only Memory)
2. (i) CD (Compact Disc)
(ii)) DVD (Digital Versatile Disc)
(ii1) Hard Disk
(iv) Pen Drives
3. We should take the following precautions at the time of
using a CD/DVD.
(i) When we are not using a CD/DVD, keep it in it cover.
(i1) Do not touch the shining side of a CD/DVD.

(iii) Donot write with pen or pencil on the backside of a
CD/DVD.

(iv) Do not bend a CD/DVD.
4.  Computer memory if of two types :
(i) Primary Memory : It is of two types :
(a) RAM (Random Access Memory)
(b) ROM (Read Only Memory)
(i1) Secondary Memory



5.

Pen drive is a small, pen like portable device that can
hold a large amount of data i.e. 1 GB, 2 GB and so on. It
is connected to the computer through the USB port of
cabinet.

F.  Answer the following questions in detail :

1.

The place in a computer where data and instructions are
stored is called the memory of the computer. These
instructions are entered into a computer through the input
devices like keyboard, mouse etc. It is made up of silicon
chip. Computer memory is the storage space where data
to be processed and instructions required for processing
are stored. It stores data in digital format and doesn’t get
worse over time.

Memory card or Flash Memory Card is a type of storage

media that allows to read data that is stored on it by using

card readers and also with the help of data cables.

Memory cards are used in digital cameras, cell phones etc.

varying in size, compatibility and storage -capacity

depending upon requirement.

Floppy Disk is small removable disk that are plastic

coated with magnetic recording material. It is a portable

storage device and can be reused a number of times.

Floppy disks are commonly used to move files between

different computer but are not very reliable.

CD stands for Compact Disc that can store the data and

programs. Optical Disc or CD is a most widely used

storage device. It can hold up to 700 MB of data. There
are two kinds of CDs :

(1) The full form of CD-R is Compact Disc Readable. In
this type of CD, data can be written only once. Later
on this data cannot be changed or erased.

(ii)) CD-RW : CD-RW stands for Compact Disc — Re-
writable. In this type of CD, data can be written
multiple times and erased as and when required.

External Hard Disk Drive is a storage device that is used

in addition to internal hard drives in order to store more

data. It also allow the user to put sensitive, confidential or
important information on them, then disconnect them and

store them in secure locations. It can be attached to a

computer through a USB or wirelessly.

Advantages :



(1) It is portable and operates on a plug and play basis.
(ii)) It allows the user to back up or store information
separate from the main internal hard drive.

Lesson 2 : MS Excel — Advances
Multiple choice questions :

1. (a) 2. (a) 3. (d)
4. (¢) 5. (b)

Write ‘T’ for true and 'F' for false statements:

1. T 2. T 3. T
4. T 5.T

Fill in the blanks :

1. chart 2. data marker 3. Axis

4. Data Validation 5. freeze
Match the following :

1.  Charts To make comparisons much easier.

2. Tick mark It is a small line intersecting an axes.

3. Chart text It is a label or title that we add to our
chart

4. Legend It is a key that identifies patterns, colours
or symbols.

5. Freeze It means to make a thing stable or stop

the movement.
Answer the following questions in short :
1. A chart is a tool in MS Excel that is used to communicate
our data graphically and thus allows us to know the
meaning behind our data.

2. We can easily change a chart type at any time. The steps
are as follows :

(i) Select the chart.

(ii)) On the Insert tab, in the charts group, choose column
and select clustered column.
3. The steps are as follows :
(1) Select the chart. We will notice that the chart tools
contextual tab is activated.
(ii)) On the design tab, click switch Row/Column.
4.  The types of charts in MS Excel are :
(i) Pie Chart (iv) Bar chart

6)



(ii)) Column Chart (v) Area Chart
(iii) Line Chart (vi) Scatter Chart etc

5. Data tools are simply tools which make it easy to
manipulate data. Some of them are used to save our time
by extracting or joining data and others perform complex
calculations on data.

6. The steps to hide worksheet are as follows :

(1) Select the sheet which we want to hide.

(i1) Now click Hide sheet from hide and Unhide options
from call group in Home Tab.

(iii) Click on Hide Sheet from hide and Unhide. We will
notice that upon click the whole sheet will be hidden.

F. Answer the following questions in details :
1.  To create a chart steps are as follows :

(i) Type the data in excel worksheet. Before making a
chart first of all we need to define a data series. A
data series is a related set of data points. In an Excel
worksheet it is usually one row of data with the
associated column headings or one column of data
with the associated row headings.

(i) Select the range A1:C6

(iii) On the Insert tab, in the charts group choose line and
select line with Markers.

2. The elements of a chart are as follows :

(i) Chart area (i) Data marker
(ii1) Data series (iv) Axis

(v) Tick mark (vi) Plot area
(vii) Gridlines (viii) Chart text

(ix) Legend

3.  Convert text to columns separate the contents of one
Excel Cell into separate columns. Steps are as follows :
(1) Type the data in our worksheet.
(i) Select the range with full names.
(ii1) On the Data tab, click text to columns.
(iv) Choose Delimited and click next.
(v) Clear all the check boxes under Delimiters except for

the Comma and Space check box.

(vii) Click Finish

4.  Data Validation is a powerful feature that is used to set up
certain rules to dictate what can be entered into a cell. For
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example; we may want to limit data entry in a particular
cell to whole numbers between 0 and 10. If the user
makes an invalid entry, we can display a custom message.
To create a data validation rule, the steps are as follows :
(for above example)

(i) Type the data in our excel worksheet.

(i1) Select cell C2.

(ii1) On the Data tab, click Data Validation

On the Settings Tab, do as shown :

(1) In the allow list, click whole number.

(i) In the Data list, click between.

(iii) Enter the Minimum and Maximum values.

Input message appears when the user selects the cell, on

the input message tabs.

(i) Check ‘Show input message when cell is selected’.

(i) Enter a title.

(iii) Enter an input message.

If user ignore the input message and enter a number that

1s not valid, then we can show error alert. On the error

alert tab.

(i) Check ‘Show error alert invalid data is entered.’

(i) Enter a title.

(iii) Enter an error message.

(iv) Click OK

To check Data Validation result

(1) Select Cell C2.

(i) Try to enter a number higher than 10.

Split worksheet is to view multiple distant parts of your

worksheet at once. To split your worksheet (window) into

an upper and lower part, execute the following steps :

(i) Select a cell in column A.

(i1)) On the view tab, in the window group, click split.

(ii1) Notice the two vertical scroll bars.

(iv) To change the window layout, use the horizontal
split bar that divide the panes.

To freeze panes, execute the following steps :

(1) Select any row.

(i) On the view tab, click Freeze panes.

(ii1) Scroll down to the rest of the worksheet.
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Result : All rows above selected row are frozen.

Define :

1. It is the area where our data is plotted and it includes the
axes and all markers that represent data points.

2.  These are the optional lines extending from tick marks
across the plot area that make easier to view the data
values represented by the tick marks.

3. A tick mark indicates a category, scale or chart data series.
A tick mark can have a label attached to it.

4. Data Validation is used to set up certain rules to dictate
what can be entered into a cell.

5. A chart title identifies the graph to the operator and is
displayed at the top of the graph.

6. A handful of errors can appear in a cell when a formula
or function in Excel cannot be resolved so an alert is
displayed.

Lesson 3 : MS Access :Advanced
Multiple choice questions :

1. (d) 2. (a) 3. (o)

4. (b) 5. (¢) 6. (b)

Write ‘T’ for true and 'F' for false statements:

1. T 2. T 3.T

4. T 5.7 6. T

Fill in the blanks :

1. RDBMS 2. data type 3. Auto Number

4. Currency 5. table 6. primary key
Match the following :

1. Text Upto 255 charcters

2. Number Long integer, integer single & double bytes
3. Memo Upto 65535 character

4. OLE object For pictures, sound, video or any other docs
5. Hyperlink It is used for links to the www or e-mail

6. Filters View only the data you want to see

Answer the following questions in short :
1. The seven major components are :

Tables, Relationship, Queries, Forms, Reports, Macros,
Modules.



Data types of access are :

Text, Number, Date/time, Yes/no, Currency, Auto Number,
Memo, OLE Objects, Hyperlink, Calculated.

The advantages of MS Access are :

(i) Easy to install and use.

(il)) Easy to integrate

(iii) Easy to import data

(iv) Multi-user support

A record is a group of related data help within the same
structure. It is a groping of fields within a table that
reference one particular objects.

A table is a database object that you define and use to
store data and update data. It consist of records and fields.
We can create table in either datasheet view or design
view by using the commands in the table group on the
ribbon.

Form is a graphical representation of a table, in which
user can insert new data, change the present data or even
can delete it.

Report in Access allows you to print assembled data in a
custom layout. We can create reports based on tables and
or queries.

Answer the following questions in details :

1.

The guidelines should be followed to design a great

database. They are —

(i) Identity all the fields needed by you to produce the
required information.

(i1) Organize each piece of data into its smallest useful
part to make the design perfect.

(iil) Make group related fields into tables.

(iv) Determine each table’s primary key which will
uniquely identified.

(v)  You will have to include a common field in related
tables.

To create table in datesheet view :

(i) Click table on the ribbon (from the create tab). A
blank table will appear.

(i1) Click Click to Add to add a new file.

Select a data type from the contextual menu that
expands when you click.

)



(iii)) Once you’ve selected a data type, Access highlights
the coloumn header so that you can name the fields.

Enter a name for the field.

Repeat steps 2 and 3 for as many fields that you
need to add.

(iv) When you create a new table, Access automatically
adds a new field called ID with a data type of Auto
Number. You can rename this field if you wish. To
do this right-click in the field and select Rename
field.

Access with highlight the field name for you to
rename it. Enter a new name as required.

(v) Once you’ve set up the table, you should save it. To
save the table, right click on the table’s tab and
select save.

(vi) Enter a name for the table and click OK.

(vii) The table is now added to the list of tables in the left
Navigation Pane.

When we create tables in design view, we have more

control over the databases design. The steps are as

follows :

(i) On the create tab, in the Table design button. A New,
black table opens in the object window in Design
view.

(i) In the field name column, type a name for the first
field. Field names can be upto 64 characters long.
They can include any combination of letters, spaces
and brackets etc.

(ii1)) In the data type column click the down arrow and
select a data type from the list.

(iv) In the description column, type a description for the
field.

(v) Repeat steps 2 through 4 to add additional fields to
the table. After entering the all fields save the table.

Filters in MS Access allows to view only the data you

want to see. In order to create filter, set criteria for the

data you want to display. The steps to apply filters are as
follows :

(i) Click the drop-down arrow next to the field you
want to filter by.



(il) A drop-down menu with a checklist will appear.
Only checked items will be included in the filtered
results. Use the following options to determine
which items will be included in your filters :
™ Select and deselect items one at a time by

clicking their check boxes.

LN Click Select All to include every item in the
filter. Clicking Select All a second time will
deselect all items.

S Click Blank to set the filter to find only the
records with no data in the selected field.

(ii1) Click OK. The filter will be applied.

5. Sorting is a process that involves arranging the data into
some meaningful order to make it easy to access. It
involves arranging data systematically and has two
common, yet distinct meaning.

Steps to implement sorting are as follows :
(i) Select a filed in the cell you want to sort.
(ii)) Click the Home tab on the Ribbon and locate the
Sort and Filter group.
(ii1) Sort the field by selecting the Ascending or
Descending command.
a. Select Ascending to sort A to Z or to sort
numbers from smallest to largest.
b. Select Descending to sort text Z to A or to sort
numbers from largest to smallest.
(iv) The table will now be sorted by the selected field.
(v) To save the new sort, click the save command on the
Quick Access toolbar.
G. Define :

1. Data type describes the kind of information in the field. It
also determines how much memory the date will us.

2. A table is a database object that you define and use to
store data, update Data. It consist of records and fields.

3. Form is a graphical representation of a table, in which
user can insert new data, change the present data or even
can delete it.

4. A query is a request for data or information from a
database table or combination of tables.

5. Report in Access allows you to print assembled data in a

&



custom layout. We can create reports based on tables and
or queries.

6. Sorting is a process that involves arranging the data into
some meaningful order to make it easy to access. It
involves arranging data systematically and has two
common, yet distinct meaning.

Lesson 4 : Photoshop Vector Tools
Multiple choice question :

1. (b) 2. (¢) 3. (a)

4. (b) 5. (a) 6. (d)
Write ‘T’ for true and 'F' for false statements:

1. T 2. T 3. F

4. F 5. T 6. T

Fill in the blanks :

1. Path 2. closed 3. start/end
4. PSD, PDF file formats 5. Shift, S
6. /100 7. High 60, Medium 30, Low 10

Answer the following questions in short :

1.  Vector tool is a shape tool to create an object for
placement on your image.

2. Anchor points are that mark the end points of the path
segments.

3. A work path is a temporary path that appears in the Paths
panel and defines the outline of a shape.

4. Typography design is an art concerned with design
elements that can be applied to the letters and text (as
opposed to, say, images, tables or other visual
enhancements) on a printed page.

5. Wrapping let’s you distort font type to conform to a
variety of shapes such as an arc or a wave. We can
change a layers warp style at any time to change the
overall shape of the warp.

6. File compression is a date compression method in which
the logical size of a file is reduced to save disk space for
easier and faster transmission over a network.

Answer the following questions in detail :

1. A path consist of one or more straight or curved segments.
Anchor points mark the end points of the path segments.
A path can be closed, with no beginning or end (for



example, a circle), or open, with distinct end points (for

example, a wavy line).

Smooth curve path are connected by anchor points called

smooth points. Sharply curved paths are connected by

corner points. A path does not have to be connected series
of segments. It can contain more than one distinct and
separate path component.

To create a U-shape curve :

(i) Drag downward. As you drag you will notice that
two handles are being created.

(ii)) Move your pointer to the right, parallel with the first
point that you made; click and drag upward. You
will now see a U shaped curve being generated. The
curve goes in the direction that you are dragging.

To create a S-curve :

(i) Drag to the left. The direction handles are being
created.

(i) Position your pointer underneath the first point. Drag
to the left again.

Intersect with selection is an operation option used for

converting a path to a selection border.

This selects the area common to both the path and the

Original selection. If the path and selection does not

overlap, nothing is selected.

If you command- Option - Shift - Click

(PC : Ctrl — Alt — Shift — Click), it will intersect the

selection.

(i) Always transform your images in their native
application. Size, crop, rotate, spear and reflect art in
Photoshop.

(i) When saving Photoshop images for print purposes,
stick to TIFF, EPS, native PSD or PDF file formats.

(ii1) Make sure that you use the proper colour mode.

(iv) Provide all fonts used in your file. Provide both
screen and Post Script printer fonts, if applicable.

(v) Organize your files into folders.

The steps for preparing file for web output are :

(i) Downsize the image.

(i) Sharpen the image.

(ii1) Save a copy of the image with th layers.



(iv) Convert the color space / flatten the image.

(v) Convert to eight-bit image.

(vi) Save the JPEG image.

6. (i) Open a new documents in Adobe Photoshop CC.
(i)  Select Custom Shape Tool from the Tools panel.
(iii)) Choose Path from the Options bar. Click the

custom shape arrow on the options bar.

(iv) Choose a custom shape from the panel.

(v)  Click and drag to draw a shape.

(vi) To add text, click the Horizontal type tool.

(vii) From the options bar, select a font, style, size and
colour of the text.

(viii) Move the mouse pointer over the edge of the shape.
Click on the shape border in the spot where you
want to start adding text.

(ix) Type and text will wrap around the shape.

Chapter 5 : Animation in Flash
Multiple Choice questions :

1. (b) 2. (a) 3. (c)

4. (a) 5.(d) 6. (b)
Write ‘T’ for true and 'F' for false statements:

1.T 2.T 3.F

4. F 5.T 6. F

Fill in the blanks :

1. web 2. unique 3. movie
4. Timeline 5. visible 6. selection
7. Lasso 8. Smooth.

Write the key/key combination for the following :

1. F6 2. Ctrl + R 3. F8

4. Ctrl + G 5.Ctl + B 6. Ctrl + R

Answer the following question in short :

1.  The default dimension size of a stage 700 x 350 pixels.

2. The frame rate is the number of frames or images that are
projected or displayed per second.
The professional frame rate for motion pictures is 12
frames her second.

3. The extension of Flash Movie file is .swf

4. The extension of the Flash Player file is .swt



5.
6.

Ips is the speed at which the animationplays.

The three states of Pencil tool are : straighten, smooth,
ink.

Answer the following questions in details :

L.

Flash is called ‘“Macromedia Flash” is a multimedia and
platform used for authoring of vector graphics, animation,
games and rich Internet applications. It is the gateway to
the state of art web contents. Its interface might look
quite complicated.

Stage is an area where you directly draw or arrange or
import enquired artwork from other sources to create a
movie. The Stage is surrounded by work area where we
can place contents. The size of the stage can be altered
according to the requirement.

Timeline window is where we coordinate the timing of
the animation and assemble the artwork in separate layers.
Timeline organises and controls a movie content in
defined time in layers and frames. The most important
components of the timeline are frames, layers and play
head.

Flash library stores symbols, including those created in
Flash and those imported into it. It allows you to view
and organize these files as you work. The library
windows displays a scroll list with the names of all the
items in the library. An icon next to an item’s name in the
library indicates the item’s file type.

Properties Panel is just below the Stage by which we can
easily manipulate all our movie content from one place.
This makes working easier. It is contextual; it changes
with the type of tool chosen.

Symbols are reusable elements that we use in a movie.
There are three types of symbols : Graphic, Button and
Movie. When we create a symbol, it is stored in Flash
library.

When a particular element is required more than once in a
movie, by converting the element into a symbol, we can
simply drag it from the library to the stage each time we
need that elements. It also helps us to reduce the file size
of the movie in flash.

Animation is a technique in which a series of images are
displayed rapidly. In Flash, we create animation by



F.

10.

I1.

12.

changing the content of successive frames. Animation,

like movies films are made up of many frames, each of

which has a slight change from last one. Flash is a smart
animation software.

There are two methods for creating an animation

sequence in Flash :

(i) Frame-by-Frame Animation : In this we create
image in every frame. This is the most time
consuming method.

(ii)) Tweened Amination : It simply means going from
one keyframe to another while taking small steps for
each of the frames in between.

Flash has three types of Tweenings :

(i) Motion Guide Tweening : Moving objects from
position A to B along a customized path.

(ii) Tint Tweenings : Graduated changing of colors of an
object.

(ii1) Shape Tweenings : Graduated change in the shape of
an object into another shape.

Motion Guide allows the object to move from one

position to another by following a customized path.

A keyframe is a frame in which you can define a change

in an animation and include frame actions to modify a

movie. It defines the starting points and ending points of

any smooth transition.

Shape Tween allows graduated change in the shape of an

object into another shape. It is the effective type of

tweening. It interpolates the intermediates shapes for the
frames in between creating the animation of one shape
morphing into another.

Arrange :

(1)
(i)
(iii)
(iv)
(v)

Draw the Sun and convert it into a symbol (F8) select the
Graphic option and name the symbol as 'Sun'. Delete it
from the stage.

Move to the library panel and drag the sun on to the stage.

To enter a keyframe in frame 20, click the frame 20 and
then press Fo.

Now right-click the 1st frame in the Timeline and select
Create Motion Tween from the pop-up menu.

In the frame 20, move the sun to a different position i.e.
right side of the stage.



(vi) Select the 10th frame and insert a Keyframe (F6) and
move the sun to another different location above the
current position to create a motion sequence
(automatically tweened by Flash).

(vii) Save your work and test the Movie (Ctrl + Enter). Finally
you have created simple animation using Motion Tween.

Chapter 6 HTML-I
Multiple Choice Questions :

1. (a) 2. (d) 3. (b)
4. (a) 5. (b) 6. (a)
7. (b)

Write ‘T’ for true and 'F' for false statements :
1.T 2.F 3.T

4. F 5.F 6. T
7.T

Fill in the blanks :

1. Front Page 2. HTML 3. start
4. definition list. 5. Empty 6. lowest
7. COLOR

Answer the following questions in short :
1. The full form of HTML is Hyper Text Markup Language.
2. HTML tag determine the way that the web browser will
display the text.
3. HTML offer three different type of lists :
(i) Ordered list
(i) Unordered list
(ii1) Definitions
4. The extension of HTML document is .html.
5. <FONT> is used to change the text color.
Answer the following questions in detail :
1. The advantages of HTML are :
(i) HTML is easy to use and understand.
(ii)) HTML is a versatile language and can be used on
any windows or other platform.

(iii) It allows the use of different tools to make the
document look more attractive.

(iv) HTML allows linking of different web pages.
(v) It is free-you need not buy any software.



To create an HTML documents, you can type the text in
any processor like Word Pad, Notepad and create the
page. Steps are :

(i) Open Notepad by clicking on Start > All Programs>
Accessories > Note pad

(ii)) Type a simple HTML document.

(ii1) Click on File > Save menu option.

(iv) The Save As dialog box will appear. Mention the
name in file name text box with an extension .html
and select the drive where you want to save the file.

(v) Click on Save button.

A definition list may contain numerous terms and

descriptions, one after the other. A definition list starts

with a <DL> tag (definition list).

Each term starts with a <DT> tag (definition term).

Each description starts with a <DD> tag (definition

description).

Inside the <dd> tag you can put paragraphs, line breaks,

images, links, other lists etc.

(i) Container Elements.

In HTML, the container is the area enclosed by the
beginning and ending tags. For example : <HTML>
encloses an entire document while other tags may
enclose single elements. All container must have start
and end tag.

For example : <FONT> ............ </FONT>

(i1) Empty Element
In HTML, the empty elements or void elements, only
have a start tag since they can’t have any content.
Instead they do something on their own.

For example <BR> tag breaks the line and displays
the text from the next line.

Heading element is a HTML element, mostful useful to

show headings and sub headings of the site and content’s

headlines in web pages. Heading elements are six,
represented with H1 H2, H3, H4, HS and H6 where <H1>

(subscript) is the highest level and <H6> (subscript) is the

lowest level. These are written within the <BODY> tag of

the document.

The Font element is used to change the size, font type or

color of the text in the web page. The syntax of the Font



element is : <FONT> ...</FONT>. The Font element uses
different attributes to enhance the text in the web page.
These attributes are color, face and size.

For example : The Size Attribute is represented as <font
size = value> <font size = “6°>

F. Define :

1.

7.

HTML is the most widely used language to design web
contents for the internet.

HTML Stands for Hyper Text Markup Language.

HTML tag determine the way that the web browser will
display the text.

Ordered list is also known as the numbered list because it
is numbered in a proper sequence. The <OL> tag is used
to create an ordered list.

It is also known as unnumbered list and start with bullets.
The <UL> tag is used to create an unordered list.

The Bold element specifies that the text enclosed in its
starting and ending tags should be displayed in bold. The
<B> ....</B> tag is used.

The Italic element indicates that the enclosed text should
be displayed in an italic typeface. The <I> ..... </I> tag is
used.

The Underline element indicates that the text should be
displayed underline. The <U>....</U> tag is used.

G.  Write what they are meant for :

Nk v

Hyper Text Markup Language.

the way that the web browser will display the text.
to create ordered list.

numerous terms and descriptions, one after the other.
the line and displays the text from the next line.

the size of the font to six.

Do yourself.

Chapter 7 HTML I1

A. Multiple Choice Questions.

1. (c)
4. (a)

2. (a) 3. (b)
5. (a)

B. Give one line code :

1.
2.

<TITLE> MY SCHOOL WEB PAGE </TITLE>
<BODY BGCOLOR= “BLUE”>



3.
4.

<HR COLOR= “YELLOW”>
<IMG SRC = “PIC1.JPG”>

C. Pick the correct answer :

1. SIZE 2. BGCOLOR
4. HTML 5. HEAD

ISAlad
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7. VLINK 8. FONT
D. Answer the following questions :

1.

Ordered list : It is also known as the numbered list
because it is numbered in a proper sequence. The <OL>
tag is used to create an ordered list. We can specify the
style attribute in the beginning. In HTML, we can use the
<OL> tag for three kinds of ordered lists:

(i) Alphabet  (ii) Numbers/digits (iii)Roman numerals
Unordered list : It is also known as unnumbered list and
starts with bullets. If you want the same list as unordered
or unnumbered list, then the tag used would be <UL>
istead of <OL>.

HREF : The meaning of href is hypertext reference. This
attribute is mandatory in anchor tag. The href attribute
takes the value as the address of the supporting document.
Both the relative and the absolute links can act as values
to the href attribute.

Example :

<a href = “http://www.w3.org/”>website of W3C</a>

A definition list may contain numerous terms and
descriptions, one after the other. Additionally, a definition
list may have multiple terms per description as well as
multiple descriptions per term. It is useful in work like a
dictionary where there are words and their meanings
listed without numbers or bullets.

A definition list starts with a <DL> tag (definition list).
Each term starts with a <DT> tag (definition term).

Each description starts with a <DD> tag (definition
description).

<BODY BACKGROUND> is used to control the
background of an HTML element, specifically page body
and table backgrounds. You can specify an image to set
background of your HTML page or table. The <IMG>
tag is empty, which means that it contains attributes only
and it has no closing tag. To display an image on a page,
you need to use the src attribute. Src stands for "source".
<a href=http://www.Littlebuds.com>



10.

The anchor element is used to link to another page or to a
certain part of the page if you use its ID. The link tag
defines a link between a document and an external
resource.

<OL>

<LI> ENGLISH <LI>

<LI> HINDI <LI>

<LI> MATHS <LI>

<LI> SCIENCE <LI>

</OL>

An <UL> unordered list is a collection of related items
that have no special order or sequence. It contains type
attribute to specify the type of bullet you like. By default
it is a disc.

We can set the color of text that acts as a link in a web
page by using HTML color codes or can also specify the
names of those colors, for example, red, blue, green, and
black. Example:

<BODY TEXT="Red" LINK="Blue" VLINK= "Green"
ALINK="Yellow" BGCOLOR="Pink">

Chapter 8 Communication on the Net

A. Multiple Choice Questions :

1. (d) 2. (c) 3.(d)
4. (¢) 5. (a) 6. (c)
B. Fill in the blanks :

1. Browsing 2. free, paid 3. E-marketing

4. communication 5. group communication

6. Acronyms 7. newsgroup

C. Answer the following questions in short :

1.  Users make use of IM language or internet slang to
abbreviate common words or expressions to quicken
conversations or keystrokes.

2. Instant messaging is a set of communication technologies
used for text based communication between two or more
participants over the Internet or other types of Network.

3. Instant Messenger : Example :

(i) Facebook messenger
(i1) Whats App.
Egreetings websites



5.

Example :

(i) www.bluemountain.com.

(i1) www.e-cards.com

Internet communication is referred to as the sharing of
information, ideas or simply words over the World Wide
Web, or the Internet. The Internet consist of a world wide
string of connected networks that exchanges data through
packet switching.

The mode of Communication are : Chat, E-mail, Video
Conferencing, Social Media etc.

D. Answer the following questions in detail :

1.

An acronym is an abbreviation formed from the initial
components in a phrase or a word. These components
may be individual letters or parts of words. There are
short forms of words that are used when we send regular
e-mail, SMS, MMS, etc. Some of the commonly used
acronyms are :

ABT : About

ASAP : As Soon As Possible

PS : Post Script

IMO : In My Opinion

Video Conferencing is a method of communication
through which people at different corners of the world
can get together and have a meeting in which they are not
physically present in one place, but are connected through
telecommunications of audio and video.

Video conferencing is also used for sharing documents,
displaying information on the computer, sharing a
whiteboard for information etc.

Newsgroups is a ‘World Wide’ platform for ‘exchanging’
ideas and information by Common minded people. People
sharing ‘similar ideas’, interest can put ‘forward’ their
views for other like minded people by to see by posting
them in the newsgroup of their hole and also ‘viewing’
other people posted articles.

A newsgroup is like a storehouse where messages from
many users are place in different locations within a
particular group.

Netiquette can be defined as a set of conventional rules to
be followed for correct behavior on the Internet. These
rules are considered appropriate behavioural rules for a
majority of Internet Users.



Some netiquette to follow while sending an e-mail :

& In case one does not have his/her own Internet
account with an Internet Service Provider, it is
mandatory to determine ownership of all e-mails.

»  An e-mail should be thought of as a postcard,
which is an open letter. One should not assume that
everything written on an e-mail would be discrete.

&  We should respect the copyright of the original
creator of any material that we use from the
Internet.

®  Try not to send chain letters. They may be carrying
undesirable programs, such as a virus.

»  One should be very careful while sending and
receiving e-mails.

&  Always make sure who the recipient of the mail
would be. Sometimes you may send it to a wrong
address.

&  Try never to send an e-mail without a subject in the
message.

The Internet is a good way to chat with people who have
an Internet connection as well as an e-mail address, all
over the world. Chat is a text-based communication that
is live or in real-time. When talking to someone in chat
any typed text is received by other participants
immediately. Chat Programs are used by users to
communicate with others 'remote' Users in Real-Time (as
in a phone call). A User can Log On to specific Websites,
and 'communicate' with other users who have also 'logged
in'. Some of the popular chat software's are :
&  Yahoo Messenger
&~  Gtalk
&  Windows Live Messenger
&  Rediff Bol
Symbol that you type in an e-mail or text message to
show how you feel. For example the emoticon :-) means
happy or friendly. An emoticon is a symbol or a
combination of symbols that we can use to express an
emotion in a message. In web forums, instant messengers,
etc. Text emoticons are often automatically replaced with
small corresponding images. For examples, the two most
common emoticons smiley face and frowsy face, can be
made with the help of a colon, hyphen, and parentheses.



Chapter 9 Computer Threats

Multiple Choice Questions :

1. (a) 2. (b) 3. (c)

4. (d) 5. (a) 6. (b)

7. (d) 8. (d)

Write ‘T’ for true and 'F' for false statements:

1. T 2.F 3.T

4. T 5.F 6.T

Fill in the blanks :

1. Hardware 2. access, deleted 3. appearing

4. Macro virus 5. hacking 6. Phishing

7. Biometric 8. Firewall, security

Answer the following questions in short :

1. (1) A Trojan horse is a hacking program that is a non-
self-replicating type of malware which gain
priveleged access to the operating system performing
undesirable function, often including unauthorized
access to the target’s computer.

(il)) A computer worm 1is a standalone malicious
computer program that replicates itself in order to
spread to other computers.

(iii) A computer virus is a type of malicious software that,
when executed, replicates itself by modifying other
computer programs and inserting its own code.

2. A computer virus is a type of malicious software that,
when executed, replicates itself by modifying other
computer programs and inserting its own code.

3. Script virus is written using script languages. They spread
and infect files by taking advantage of vulnerability ties,
opening e-mail or accessing web pages which include
scripts will activate virus.

4.  Symptoms of Computer Virus are :

(1)

(i)
(iii)

(iv)
™)

You are unable to access files, or the contents of the
files get deleted.

The computer crashes and restarts every few minutes.
The computer runs slower than usual, and takes
longer time to load programs.

You notice unusual and strange messages such as
‘your PC is stoned ?

New icons appear on the Desktop. Strange Graphics
are displayed on the monitor.



E. Answer the following questions in detail :

1.

Anti-virus software are software for your computer is
used to prevent, detect and remove malware, including
computer viruses, worms, and trojan horses.

Some examples of anti-virus software are MCAfee,

Norton, and KaperSky.

(i) The computers on a network can get infected when
an infected file is shared among them.

(i) One of the most common ways a computer becomes
infected is the user accepts on the screen without
reading the prompt.

(ii1) Computer become infected with viruses and other
spyware is by opening email attachments that can be
faked or even when not faked your acquaintance
may be forwarding you an infected file.

(iv) Your computer may get infected by copying infected
files from CDs and pen drives.

Some precautions to secure and protect important data

are :

(i) Do not share your password with anyone and strong
password and pin must be used for stronger
protection.

(ii)) The confidential data must be encrypted. Every
option involves coding of data.

(ii1) Use security devices such as firewall that so
separates a secure area from a less secure area.

It prevents unauthorized access to or from a private
network.

(iv) Do not click on any links which you are not
confirmed about.

Phishing is a very specific type of cybercrime that is

designed to trick you into disclosing valuable information

such as details about your bank account or credit cards.

Often, cybercriminals will create a fake website that looks

just like a legitimate site such as a bank's official website.

The cybercriminal will try to trick you into visiting their

fake site typically by sending you an email that contains a

hyperlink to the fake site. When you visit the fake

website, it will generally ask you to type in confidential
data such as your login password or PIN and you will be
attached by attacher.

A firewall is a security device that can be a software

@



program or a dedicated network appliance. The main
purpose of a firewall is to separate a secure area from a
less secure area and to control communications between
the two. Firewall can perform a variety of other functions,
but are chiefly responsible for controlling inbound and
outbound communications on anything from a single
machine to an entire network. A firewall is a system
designed to prevent unauthorized access to or from a
private network. You can implement a firewall in either
hardware or software form, or a combination of both.
Firewall prevent unauthorized Internet users from
accessing private networks connected to the Internet,
especially Internet All messages entering or leaving the
intranet (i.e., the local network to which you are
connected) must pass through the firewall, which
examines each message and blocks those that do not meet
the specified security criteria.

Computes viruses is a type of malicious software that
when executed, replicates itself by modifying other
computer programs and inserting its our code. When this
replication succeeds the affected areas are then said to be
“infected” with a computer virus.

Boot sector virus : This virus loads itself to the boot
sector of the floppy disk or master record of hard disk in
order to be loaded to the memory before the operating
system is loaded. As soon as the virus becomes residence
it will be able to infect each inserted disk to that
computer.

Macro virus : Macro virus is a type of mini-program that
can easily infect a particular computer system. Macro
virus runs inside another program. Macro virus possesses
immense ability to spread in a swift manner thus infecting
popular applications used for everyday computing
purposes.



